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Chapter 1 : Workspace basics in InDesign
When you run a query in SSMS, you are probably aware that the status bar contains many pieces of information about
it. Things like the instance name that you are connected to, the login name used, and a few others.

Any arrangement of these elements is called a workspace. The workspaces of the different applications in
Adobe Creative Cloud share the same appearance so that you can move between the applications easily. You
can also adapt each application to the way you work by selecting from several preset workspaces or by
creating one of your own. The Start workspace is displayed when: InDesign is launched Use the Start
workspace to: Learn Click this tab to open a list of basic and advanced tutorials on InDesign to get started with
the application. Create New Click this button to create a new document. You can create a document by
selecting one of the numerous templates and presets available in InDesign. Open Click this button to open an
existing document in InDesign. Create documents When you create a document in InDesign, instead of
beginning with a blank document, you can choose from a wide variety of templates, including templates from
Adobe Stock. Templates include assets that you can build on to complete your project. When you open a
template in InDesign, you can work with it just as you would work with any other InDesign document. In
addition to templates, you can also create a document by selecting one of the numerous presets available in
InDesign. For more information, see Create documents. New Document dialog Templates from Adobe Stock
and presets Workspace overview The Application frame groups all the workspace elements in a single,
integrated window that lets you treat the application as a single unit. When you move or resize the Application
frame or any of its elements, all the elements within it respond to each other so none overlap. If you work with
two or more applications, you can position each application side by side on the screen or on multiple monitors.
If you are using a Mac and prefer the traditional, free-form user interface, you can turn off the Application
frame. The Application bar across the top contains a workspace switcher, menus Windows only , and other
application controls. On Mac, the application bar is available only when Application frame is off. You can
toggle it on or off using the Window menu. The Tools panel contains tools for creating and editing images,
artwork, page elements, and so on. Related tools are grouped. The Control panel displays options for the
currently selected object. Document windows can be tabbed and, in certain cases, grouped and docked. Panels
help you monitor and modify your work. Panels can be grouped, stacked, or docked. Default InDesign
workspace A. Tools panel Set UX color You can change the interface to one of the four available color
options: Do one of the following: Available color themes Select Match Pasteboard To Theme Color to set the
color of the pasteboard to the selected color theme. Deselect to set the color of the pasteboard to white. You
can temporarily display hidden panels if Auto-Show Hidden Panels is selected in Interface preferences. Move
the pointer to the edge of the application window Windows or to the edge of the monitor macOS and hover
over the strip that appears. Display panel options Click the panel menu icon in the upper-right corner of the
panel. You can open a panel menu even when the panel is minimized. Adjust panel brightness In Interface
preferences, you can customize the interface to sport one of the four available color themes designed for
optimal user experience: The pasteboard color in InDesign is matched to the theme color by default.
Reconfigure the Tools panel You can display the tools in the Tools panel in a single column, or side by side in
two columns. Click the double arrow at the top of the Tools panel. Rearrange, dock, or float document
windows When you open more than one file, the Document windows are tabbed. To dock a Document
window to a separate group of Document windows, drag the window into the group. To create groups of
stacked or tiled documents, drag the window to one of the drop zones along the top, bottom, or sides of
another window. You can also select a layout for the group by using the Layout button on the Application bar.
Dock and undock panels A dock is a collection of panels or panel groups displayed together, generally in a
vertical orientation. You dock and undock panels by moving them into and out of a dock. To dock a panel,
drag it by its tab into the dock, at the top, bottom, or in between other panels. To dock a panel group, drag it
by its title bar the solid empty bar above the tabs into the dock. To remove a panel or panel group, drag it out
of the dock by its tab or title bar. You can drag it into another dock or make it free-floating. Links panel being
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dragged out to new dock, indicated by blue vertical highlight Links panel now in its own dock Note: You can
prevent panels from filling all the space in a dock. Drag the bottom edge of the dock up so it no longer meets
the edge of the workspace. Move panels As you move panels, you see blue highlighted drop zones, areas
where you can move the panel. For example, you can move a panel up or down in a dock by dragging it to the
narrow blue drop zone above or below another panel. If you drag to an area that is not a drop zone, the panel
floats freely in the workspace. To move a panel, drag it by its tab. To move a panel group, drag the title bar.
Narrow blue drop zone indicates Color panel will be docked on its own above the Layers panel group. Press
Esc while moving the panel to cancel the operation. Add and remove panels If you remove all panels from a
dock, the dock disappears. You can create a dock by moving panels to the right edge of the workspace until a
drop zone appears. To remove a panel, right-click Windows or Control-click Mac its tab and then select Close,
or deselect it from the Window menu. To add a panel, select it from the Window menu and dock it wherever
you want. To remove a panel from a group so that it floats freely, drag the panel by its tab outside the group.
To move a group, drag the title bar the area above the tabs. Stack floating panels When you drag a panel out of
its dock but not into a drop zone, the panel floats freely. The floating panel allows you to position it anywhere
in the workspace. You can stack floating panels or panel groups so that they move as a unit when you drag the
topmost title bar. To stack floating panels, drag a panel by its tab to the drop zone at the bottom of another
panel. To change the stacking order, drag a panel up or down by its tab. Be sure to release the tab over the
narrow drop zone between panels, rather than the broad drop zone in a title bar. To remove a panel or panel
group from the stack, so that it floats by itself, drag it out by its tab or title bar. Resize panels To minimize or
maximize a panel, panel group, or stack of panels, double-click a tab. You can also double-click the tab area
the empty space next to the tabs. To resize a panel, drag any side of the panel. Some panels, such as the Color
panel in Photoshop, cannot be resized by dragging. Collapse and expand panel icons You can collapse panels
to icons to reduce clutter on the workspace. In some cases, panels are collapsed to icons in the default
workspace. Panels collapsed to icons Panels expanded from icons To collapse or expand all panel icons in a
column, click the double arrow at the top of the dock. To expand a single panel icon, click it. To resize panel
icons so that you see only the icons and not the labels , adjust the width of the dock until the text disappears.
To display the icon text again, make the dock wider. To add a floating panel or panel group to an icon dock,
drag it in by its tab or title bar. Panels are automatically collapsed to icons when added to an icon dock. To
move a panel icon or panel icon group , drag the icon. You can drag panel icons up and down in the dock, into
other docks where they appear in the panel style of that dock , or outside the dock where they appear as
floating icons. Use panel menus Access the panel menus using the icon on the upper-right corner of the panel.
Panel menu Swatches panel Save and switch workspaces By saving the current size and position of panels as a
named workspace, you can restore that workspace even if you move or close a panel. The names of saved
workspaces appear in the workspace switcher in the Application bar. Type a name for the workspace. Under
Capture, select one or more options: Panel Locations Saves the current panel locations. Menus or Menu
Customization Saves the current set of menus. Display or switch workspaces Select a workspace from the
workspace switcher in the Application bar. Delete a custom workspace Select Delete Workspace from the
workspace switcher, select the workspace, and then click Delete. When the toolbox is displayed in a single
column, you can select view modes by clicking the current mode button and selecting a different mode from
the menu that appears. Normal Mode Displays artwork in a standard window with all visible grids and guides
showing, non-printing objects showing, and a white pasteboard. Preview Mode Displays artwork as if it were
output, with all non-printing elements suppressed grids, guides, non-printing objects , and the pasteboard set to
the preview background color defined in Preferences.
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Chapter 2 : Controlling Point Selections
Re: Controlling The Status Bar Thanks njimack That's a good idea but its about controlling what the user can and cannot
do and I don't want them to be able to change anything I haven't included a control for.

Lori Kaufman March 28, , To show and hide items on the status bar, right-click anywhere on the status bar
and select the items you want to see. Any items preceded by a check mark will display on the status bar. Note
that some items only display on the status bar under certain conditions, even when they are enabled. The
Customize Status Bar popup menu stays open so you can select and deselect multiple options. Simply click
anywhere outside the popup menu to close it. When these indicators are enabled, they display on the status bar
when their respective features are toggled on. If the features are off, you will not see the indicators on the
status bar. Note that clicking on these indicators does not toggle the features on and off. You can only do so
from the keyboard. Overtype Mode allows you to replace whatever is to the right of the insertion point as you
type. When the Overtype Mode option for the status bar is enabled, and Overtype Mode is on, you will see the
indicator on the status bar. Note that the Insert key on the keyboard will always toggle between the Insert
Mode and Overtype Mode while you are in Excel. You cannot disable this functionality of the Insert key in
Excel like you can in Word. The Selection Mode option on the status bar is enabled by default and indicates
which mode is being used when you are extending or adding to a selection of cells. Use these buttons to
change the view of the current worksheet. Each worksheet in your workbook can have a different view. The
Page Number option on the status bar is enabled by default and displays the current page number and total
number of pages on the left side of the status bar. However, the page number only displays when the Page
Layout view is selected from the View Shortcuts described above. The Average, Count, and Sum options on
the status bar are enabled by default. The Zoom percentage and Zoom slider are enabled by default and allow
you to zoom in to have a closer look at your worksheet, or zoom out to see more of your worksheet at once. In
earlier versions of Excel, you could hide the status bar if you wanted more space available for your
worksheets. However, that capability was removed starting with Excel So you might as well make it as useful
as possible.
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Chapter 3 : Excel status bar options - Excel
The status bar at the bottom of Office programs displays status on options that are selected to appear on the status bar.
Many options are selected by default. If you want to customize the status bar, right-click it, and then click the options that
you want. The following options are available on.

Less The status bar at the bottom of Office programs displays status on options that are selected to appear on
the status bar. Many options are selected by default. If you want to customize the status bar, right-click it, and
then click the options that you want. The following options are available on the status bar in Excel. A few
options may not be available depending on the Excel version you are using. This option Displays the
following on the status bar Cell Mode Selected by default, this option displays the current cell editing mode on
the left side of the status bar. One of the following modes is displayed. Ready to indicate a general state. Enter
to indicate content entry mode. It is displayed when you select a cell and start typing, or when you press F2
twice. Edit to indicate in-cell editing mode. It is displayed when you double-click a cell, or when you press F2
so that you can enter or edit data in a cell. Point to indicate formula cell selection mode. It is displayed when
you start a formula and then click the cells that you want to include in the formula. Flash Fill Blank Cells
Selected by default, this option indicates the number of cells that were left blank after a Flash Fill operation.
Flash Fill Changed Cells Selected by default, this option indicates the number of cells that were populated by
the Flash Fill. Signatures Selected by default, this option indicates that the active workbook has been digitally
signed. Information Management Policy Selected by default, this option indicates that Information Rights
Management IRM has been used to restrict permission to content in the active workbook. Permissions
Selected by default, this option displays an icon next to the Cell Mode indicator that you can click to view the
current read and edit document permissions. This icon displays only when access to the document has been
restricted. This option is not selected by default. Fixed Decimal Selected by default, this option displays Fixed
Decimal to indicate that all numerical values that you enter on the worksheet will be displayed with fixed
decimals. This option is turned on when you select the Automatically insert a decimal point check box under
Editing options on the Advanced tab of the Excel Options dialog box in Excel , click Microsoft Office Button ,
Excel Options, Advanced. Overtype Mode When selected, this option displays Overtype to indicate that
INSERT was pressed to activate overtype mode while editing cell contents in cell editing mode double-click a
cell or press F2. Pressing END followed by an arrow key moves the selection in the direction of the arrow key,
stopping at the start and end of data, and then the start or end of the worksheet. Macro Recording Selected by
default, this option displays a button next to the Cell Mode indicator that you can click to start recording a
macro. Selection Mode Selected by default, this option displays one of the following cell selection modes.
Extend Selection when you press F8 to extend the cell selection by using arrow keys. Page Number Selected
by default, this option displays the page number of the selected worksheet page and the number of pages in the
worksheet when you are working in Page Layout view or Print Preview view. Average Selected by default,
this option displays the average that is calculated from selected cells that contain numerical values. Count
Selected by default, this option displays the number of selected cells. Numerical Count When selected, this
option displays the number of selected cells that contain numerical values. Minimum When selected, this
option displays the minimum numerical value in selected cells. Maximum When selected, this option displays
the maximum numerical value in selected cells. Sum Selected by default, this option displays the sum of
numerical values in selected cells. Upload Status Selected by default, this option indicates the upload status of
the spreadsheet to the web. You can click these buttons to change the current view. Zoom Selected by default,
this option displays the Zoom level. You can click Zoom to open the Zoom dialog box, where you can specify
the percentage of magnification that you want to use. Zoom Slider Selected by default, this option displays the
Zoom slider with the Zoom out and Zoom in buttons. You can then drag the slider or click the Zoom out and
Zoom in buttons to magnify the content of the worksheet to have a closer look, or to reduce the size of the
content on the worksheet so that you can view more content. Expand your Office skills.
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Chapter 4 : What is a Status Bar?
The status bar at the bottom of Excel's window can tell you all kinds of interesting information, such as whether Num
Lock is on or off, the page number, and the average of numbers in selected cells. Even better, you can easily customize
the status bar to show just the information you want. To.

The latest version of this topic can be found at Control Bars. Control bar" is the general name for toolbars,
status bars, and dialog bars. Control bars are windows that display rows of controls with which users can
select options, execute commands, or obtain program information. Types of control bars include toolbars,
dialog bars, and status bars. In MFC version 6. Brief introductions to the control-bar types follow. For further
information, see the links below. Class CControlBar provides the common functionality of all toolbars, status
bars, and dialog bars. CControlBar provides the functionality for positioning the control bar in its parent frame
window. Because a control bar is usually a child window of a parent frame window, it is a "sibling" to the
client view or MDI client of the frame window. Toolbars A toolbar is a control bar that displays a row of
bitmapped buttons that carry out commands. Pressing a toolbar button is equivalent to choosing a menu item;
it calls the same handler mapped to a menu item if that menu item has the same ID as the toolbar button. The
buttons can be configured to appear and behave as pushbuttons, radio buttons, or check boxes. A toolbar is
usually aligned to the top of a frame window, but an MFC toolbar can "dock" to any side of its parent window
or float in its own mini-frame window. A toolbar can also "float" and you can change its size and drag it with
a mouse. Note As of MFC version 4. Older toolbars are still supported, however. See the article ToolBars.
Status Bars A status bar is a control bar that contains text-output panes, or "indicators. Message line examples
include the command help-message lines that briefly explain the selected menu or toolbar command in the
leftmost pane of the default status bar created by the MFC Application Wizard. Status bars are usually aligned
to the bottom of a frame window. Dialog Bars A dialog bar is a control bar, based on a dialog-template
resource, with the functionality of a modeless dialog box. Dialog bars can contain Windows, custom, or
ActiveX controls. As in a dialog box, the user can tab among the controls. Dialog bars can be aligned to the
top, bottom, left, or right side of a frame window and they can also be floated in their own frame window.
Rebars A rebar is a control bar that provides docking, layout, state, and persistence information for rebar
controls. A rebar object can contain a variety of child windows, usually other controls, including edit boxes,
toolbars, and list boxes. A rebar object can display its child windows over a specified bitmap. It can be
automatically or manually resized by clicking or dragging its gripper bar.
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Chapter 5 : iPhone HTML apps - Status bar control (color control) | blog.quintoapp.com
With AutoCAD came the annoyance of being able to display the status bar icons as text. And even more frustrating is
that not all of the normal Status Bar icons that we are used are even displayed. To toggle a certain status bar icon, use
the bottom left corner button with 3 stacked lines called.

This article helps you fix the problem. If you are using Internet Explorer 7 or Internet Explorer 8, visit the
following Microsoft Website for more information: Customize the Internet Explorer toolbars Method 2 If
method 1 is not working, try to press F11 on the keyboard because the Internet Explorer may in full screen
mode. Method 3 If method 2 is not working, try the method below: Important This section, method, or task
contains steps that tell you how to modify the registry. However, serious problems might occur if you modify
the registry incorrectly. Therefore, make sure that you follow these steps carefully. For added protection, back
up the registry before you modify it. Then, you can restore the registry if a problem occurs. For more
information about how to back up and restore the registry, click the following article number to view the
article in the Microsoft Knowledge Base: Locate and then click the following registry subkey: In the details
pane, locate the Explorer subkey, and then open it. In the details pane, locate the ITBarLayout value.
Right-click this value, and then click Delete. In the details pane, locate the WebBrowser subkey, and then
open it. On the File menu, click Exit to exit Registry Editor. Now go to the "Did this fix the problem? Did this
fix the problem? Check whether the problem is fixed. If the problem is fixed, you are finished with this article.
If the problem is not fixed, you can try the following: Close all open Internet Explorer and Windows Explorer
windows. Click Start, and then click Run. In the Open box, type regedit, and then click OK. More information
After you fix this problem, any toolbar layout customizations are removed, and the affected toolbar is reset to
its default configuration. To do this, follow these steps: Right-click a blank area of the toolbar or the menu bar
Click the Address Bar item.
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Chapter 6 : Status bar - Wikipedia
I'm just going to check that the status bar bit works with my code. My solution for the address bar bit is to use a frames
page but have the top frame '0' in height and have my active page in the 'lower' frame.

With the Mode combobox you can define the identify mode: The identify tool allows you to auto open a form.
In this mode you can change the feautures attributes. Other functions can be found in the context menu of the
identified item. For example, from the context menu you can: View the feature form Copy feature: Copy all
feature geometry and attributes Toggle feature selection: Copy only the value of the attribute that you click on
Copy feature attributes: Copy only attributes Clear result: Remove results in the window Clear highlights:
Remove features highlighted on the map Highlight all Activate layer: Choose a layer to be activated Layer
properties: Activate the Enable grid checkbox and set grid definitions according to the layers loaded in the
map canvas. Activate the Draw annotations checkbox and set annotation definitions according to the layers
loaded in the map canvas. Click [Apply] to verify that it looks as expected. Click [OK] to close the dialog.
Enter the text you want to place on the map. You can use HTML as shown in the example. Choose the
placement of the label from the Placement combo box. Enable Copyright Label checkbox is checked. In the
example above, which is the default, QGIS places a copyright symbol followed by the date in the lower
right-hand corner of the map canvas. At present, there is only one style available. You can adjust the angle of
the arrow or let QGIS set the direction automatically. If you choose to let QGIS determine the direction, it
makes its best guess as to how the arrow should be oriented. For placement of the arrow, you have four
options, corresponding to the four corners of the map canvas. You can control the style and placement, as well
as the labeling of the bar. To add a scale bar: Choose the placement from the Placement combo box. Choose
the style from the Scale bar style combo box. Select the color for the bar Color of bar or use the default black
color. Set the size of the bar and its label Size of bar. Enable scale bar checkbox is checked. Optionally, check
Automatically snap to round number on resize. Tip Settings of Decorations When you save a. Use the Text
Annotation tool and click into the map canvas. Annotation text dialog Double clicking on the item opens a
dialog with various options. There is the text editor to enter the formatted text and other item settings. For
instance, there is the choice of having the item placed on a map position displayed by a marker symbol or to
have the item on a screen position not related to the map. The item can be moved by map position by dragging
the map marker or by moving only the balloon. The icons are part of the GIS theme, and they are used by
default in the other themes, too. The Move Annotation tool allows you to move the annotation on the map
canvas. Using the Html Annotation tool, click into the map canvas and add the path to the html file into the
dialog. This is similar to the designer forms for the Identify features tool, but displayed in an annotation item.
Also see this video https: Enter a descriptive name for the bookmark up to characters. Press Enter to add the
bookmark or [Delete] to remove the bookmark. Note that you can have multiple bookmarks with the same
name. The Geospatial Bookmarks dialog allows you to zoom to or delete a bookmark. You cannot edit the
bookmark name or coordinates. You can also zoom to a bookmark by double-clicking on it. Confirm your
choice by clicking [Yes], or cancel the delete by clicking [No]. Here is a small example: Press to look for
another project from the Alaska dataset. Select the project file grassland. Press Ctrl and click on the layers
grassland and regions. The selected layers are embedded in the map legend and the map view now.
Chapter 7 : Controlling what appears in the status bar and query tabs (Day 32) - Wayne Sheffield
Click on those three lines and you can see that you can customize your status bar by switching on whichever status and
drafting settings you want to use. So, something like dynamic input for example. You might want that to be able to
switched on and off on the status bar.

Chapter 8 : How to Customize and Use the Status Bar in Excel
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The status bar is located at the bottom of the application. The left side includes tools to help you use the current
command or tool. The right side includes the size of the current PDF page and the current cursor position.

Chapter 9 : Using the Toolbar and Status Bar - Windows drivers | Microsoft Docs
A status bar is a control bar that contains text-output panes, or "indicators." The output panes are commonly used as
message lines and as status indicators. Message line examples include the command help-message lines that briefly
explain the selected menu or toolbar command in the leftmost pane of the default status bar created by the MFC.
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